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Disclaimer  
 

Interactive Individual Identification 
System - Classic version 4.0 

 
 
I3S Classic is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License, version 2 or any later version published by the Free 
Software Foundation. 
 
This manual is released under the terms of the GNU Free Documentation License, 
version 1.1 or any later version published by the Free Software Foundation. 
 
This program is distributed in the hope that it will be useful, but  
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY 
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details. 
 
You should have received a copy of the GNU General Public License and GNU Free 
Documentation License along with the distribution (COPYING GPL v2.txt and 
COPYING.DOC.txt) If one of these files is missing, write to the Free Software 
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA. 
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1 Introduction to I
3
S Classic 

1.1 What is I
3
S Classic? 

I
3
S is an acronym of Interactive Individual Identification System. The name explains most of I

3
S 

Classic’s functionality. First, we will focus on the interactive part. I
3
S Classic requires user interaction 

and is meant to support and not to replace the researcher. Initially, you have to point out the location 
of the spots of the unknown individual animal. In the next step, I

3
S Classic assists you in the tedious 

task of matching animals for identification purposes. It automatically matches an annotated image of 
an unknown animal with all annotated images in the identification database and shows a ranked list 
of images. However, you will always be responsible for making the final match between the unknown 
image and an image from the identification database. Please note that we distinguish between your 
database with all images taken and the identification database. The identification database should 
only contain the best images of known individuals and preferably 3 to 5 of each individual.   
 
I
3
S Classic is the first release in a series of related software tools. This package is based on 

annotation of the spot centers and is used for animals with lots of similarly shaped spots such as 
whale sharks. The second package was named I3S Manta. This package is now called I3S Spot and 
focuses on animals with less spots and more variation. Instead of annotating the centers only, spots 
are annotated by the closest fitting ellipse around each spot, in this way taking spot size and shape 
into account. The third package was I

3
S Contour, which used the contour of e.g. flukes for 

identification. The fourth package, I
3
S Pattern, extracts key points automatically and should be used 

for animals with complex patterns where it is not possible to annotate separate spots easily and/or 
consistently. 
 
We refer in the remainder of this manual to I

3
S Classic as I

3
S.  

1.2 The algorithm 

1.2.1 The reference points 

To be able to correct for differences in viewing angle, rotation and scaling, the user is always 
required to point out three fixed reference points. The reference points should satisfy the following 
requirements: 
 
1. Their exact location is consistently and clearly distinguishable. 
2. Visible in all images. 
3. The triangle made up by the three reference points should cover most of the region of interest 

used for identification. Ideally the triangle should have angles of 60 degrees. In most cases this 
will not be possible, but you should try to get as close as possible for optimal results. 

1.2.2 Spot localization 

To help recognize individual characteristics I
3
S requires the user to locate the center of the spots in 

the identification area. The image should be taken ideally perpendicular to the line of sight and no 
more than 30 degrees off that line.  
 
Once the spots are indicated, the collection of spots and reference points is stored in what is called a 

‘fingerprint file’. You recognize these files by the extension .fgp. In the identification step, the 
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resulting spot pattern is matched with the patterns of all the known animals in the identification 
database. 
Figure 1.1 shows the reference points advised for a ragged tooth shark in blue. Do not mix-up these 
reference points as this will inhibit proper recognition. See section 4.1.3 if you want to change the 
names of the reference points. 
 
Each new species will require careful selection of the three reference points as this is critical for 
performance of I

3
S. If you want to use I

3
S on a new species you are advised to consult the I

3
S team 

for support at: i3s [at] reijns.com. 
 
 

 

Figure 1-1: Ragged tooth shark with reference points and spots.  
(Image source: Univ. of Kwazulu-Natal) 

1.2.3 Spot pattern comparison 

With the reference points selected it is now possible to correct for rotation and scaling and compare 
two images in roughly the same 2D recognition space or coordinate system. A comparison of two 
images comes down to finding corresponding spot pairs in the above-mentioned coordinate system. 
In the current implementation a spot pair is accepted as a good match if the nearest other candidate 
is at sufficient distance from the current match.  
 
Figure 1.2 shows the (centers of the) spots of two different images of the same ragged tooth shark in 
this coordinate system. The red circles denote the spots of the first image while the blue circles 
represent the spots of the second image. The green lines indicate whether two spots are considered 
a matching pair. From these pairs a distance metric is calculated to be able to rank each image in the 

mailto:i3s@reijns.com
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database. The current metric is the sum of the distances between each spot pair, divided by the 
square of the number of spot pairs. When comparing two fingerprints I3S may generate thousands of 
potential ways to map the two fingerprints onto each other. Only the best mapping is used. 
 

 

Figure 1-2: Comparison of the spots from two images. 

 
Obviously, there are some limitations to this approach. 2D linear transformations work best for 2D 
linear animals, which do not exist. However, this approach has proven to be effective if some 
constraints are considered. For a more detailed discussion on the practical issues you are referred to 
Chapter 6.  
 
For details on the algorithm, you are referred to our paper: A computer-aided program for pattern-
matching natural marks on the spotted raggedtooth shark Carcharias taurus (Rafinesque, 1810), A.M 
Van Tienhoven, J.E. den Hartog, R.A. Reijns & V.M. Peddemors, Journal of Applied Ecology 44, 
273–280 (2007). For specific details on the implementation, please contact the I

3
S team by email or 

consult the source code delivered with the distribution. 

1.3 I3S Version numbering 

The version number is related to I
3
S Pattern. The previous version of I

3
S Classic was 2.0. 

http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
http://www.blackwell-synergy.com/doi/abs/10.1111/j.1365-2664.2006.01273.x
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1.4 I3S Updates 

I
3
S will automatically check for updates and new releases. This feature will be implemented in all I

3
S 

software packages in version 3.0 and higher. Every 30 days, upon start-up of I
3
S, it will check for 

updates. If an update is available, it will ask you if it should download and install a new version. After 
each update I

3
S will ask if you want to see the release notes on the website. 

 

  

Figure 1-3: Update check. 

Please note that downloading and installing updates only works in Windows Vista or Windows 7 if 
User Account Control is turned off and if you have sufficient rights. UAC prevents I

3
S to copy files to 

protected locations such as C:\Program Files even if you have administrator rights. You can 

manually set this parameter via the Control Panel of your computer.  

1.5 What is new in this version 

I
3
S Classic v4.0 offers significant improvements over version 2.0: 

 

 Improved user interface showing the results. Now it is possible to view the image from the 
result list. With AutoZoom you directly zoom in on the area of interest. Finally, you can tell I

3
S 

to show either file names or directories in the result list. 

 Accuracy of the algorithm improved on the test databases (whale sharks and ragged tooth 
sharks). 

 Speed of the recognition improves by a factor 3 because I
3
S now uses the parallel processing 

power of your computer. 

 The possibility to use and manage multiple databases. 

 Easy and user-friendly definition of your own meta data structures. 

 Various tools to evaluate the performance of I
3
S on your database and to compare two 

databases. 

 I
3
S comes with the possibility of automatic updates. 

 Key parameters of the recognition algorithm can be tailored for your specific data set. 

 Various minor bug fixes and improvements. 

1.6 Reading this document 

In this document all file names, directory names and shell commands are written using the font 

Courier New. All names relating to a part of the I
3
S user interface, such as button names or menu 

options, are boxed. If a message is particularly important the margin will show a large red boxed 

exclamation mark.  

1.7 Bug reports, comments and requests 

Please send all bugs, comments and questions to i3s [at] reijns.com. In case of a bug, describe 
clearly how we can reproduce the bug ourselves. If possible provide us with all relevant data such as 
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images and fgp-files. We will always treat your data as confidential. Data will not be distributed to 
others without your explicit consent.  
 

An error log file will be written in the _ErrorLogs directory in your data directory when internal 

errors are reported by the software. This file (or files) can also be sent to the I
3
S team along with any 

bug report. 
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2 Installation of I
3
S Classic 

2.1 System requirements 

This version of I
3
S requires a Windows 32-bits or 64-bits operation system (XP/Vista/Windows7). 

Windows 8 probably works as well, but we have not specifically tested this operating system. The 
software is developed using Java 1.6/1.7 and C++ (MS Visual C++ 2010). Both Java and most of the 
C++ code are platform independent and it should therefore be relatively simple to port it to other 
platforms such as Linux or Mac OS. 
 
Hardware requirements are at least 2GB of memory (preferably 3 GB or more), and a 2 GHz CPU or 
faster. Increase of the identification database to hundreds of images will increase the preferred 
requirements on CPU speed but will have a limited impact on the memory requirements. Comparison 
is linear in computational requirements, i.e. an identification database with twice the number of 
individuals will require twice the time to compare with. 

2.2 Software and data requirements 

Because the main program is developed in Java, the Java Run-time Environment (JRE) is required. 
This distribution will only work with a 32-bits JRE version 1.7.0 or higher! The JRE 7 (or higher) 
can be downloaded for free from the Java website (http://www.java.com/en/download/manual.jsp) or 
Oracle website (http://www.oracle.com/technetwork/java/javase/downloads/java-se-jre-7-download-
432155.html  and download version Windows x586 Offline). 
 
Note: I

3
S currently only works with the 32-bits version of the JRE. I

3
S has been developed on a 64-

bits version of Windows 7, however with a 32 bits JRE. If a 64-bit JRE is used, I
3
S will report an error 

at start-up of the program. 
 

I
3
S supports both JPEG (extension .jpg) and GIF (extension .gif) images. Support of other image 

types is currently note foreseen as all known digital cameras can store images as JPEG. 

2.3 Installation 

Make sure you have administrator rights and turn User Account Control (UAC) off. UAC prevents the 
proper installation of the Windows environment variables. 
 

Run the file I3SClassic_v4.0_Setup.exe. If your current Java version is not sufficient you will 

be notified and installation terminates. It is required to install the Java Runtime Environment 1.7.0 (or 
higher) first.  
 
Apart from some information about the GNU-license, the installation consists of the following steps: 
1. Choosing the home directory where to install the program. Default will be in the directory  

C:\Program Files (x86)\I3SCLASSIC. 

2. Choosing whether you want to store an example data directory with image and fingerprint files.  
3. You can indicate if you want I

3
S to create a folder in the Start menu folder.  

4. Finally, you can select some additional tasks: 
a. Creating a desktop item. 
b. Copy tutorial examples in the data directory. 
c. Copy the source code. Only if you are interested in using or changing the source code 

you need to check this item. 

http://www.java.com/getjava
http://www.oracle.com/technetwork/java/javase/downloads/java-se-jre-7-download-432155.html
http://www.oracle.com/technetwork/java/javase/downloads/java-se-jre-7-download-432155.html
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5. If you selected to copy the tutorial images, you will be asked for the location. Please do not store 

the data in the C:\Program Files (x86)directory or one of its subdirectories as this may 

result in errors while using I
3
S. Choose another location such as C:\MyData. 

 
Because an environment variable has been added you are asked if you want to restart the computer 
now or later. I

3
S will not work properly until you restart the computer or logout and login again. 

 
If you want to install I

3
S under another account, this is possible. At start-up the application will search 

for the I3SCLASSIC_INSTALL environment variable which has as value the directory where I
3
S is 

installed. The default location is C:\Program Files (x86)\I3SCLASSIC. The installer creates 

this variable in the HKEY_LOCAL_MACHINE section of the registry which means that it is available for 

all users. If this variable is not found, the application terminates. At the first start-up by another user 
just select an existing database or create a new database. 
 
 

 

Figure 2-1: Uninstall via start menu. 

2.4 Uninstall 

You can uninstall I
3
S in two simple steps: 

 
1. Uninstall I

3
S, using the entry in the start menu (Figure 2-1).  

 
2. Optionally you can also uninstall the Java Runtime Environment (JRE). In general it is not a good 

idea to uninstall JRE without replacing it for a newer version because other programs may 
depend on it. However, if you still want to uninstall JRE use the standard procedure: Select 
Programs and Features  in the Control Panel. Then select the appropriate item from the list and 
click on the Add/Remove button.  

2.5 Quick introduction with video tutorials 

Examples are shown in our instruction videos. These video tutorials are available online at YouTube. 
Search in YouTube for “I3S channel”. The links to these videos are also available at the website and 

via the Help menu. Many of the videos for I
3
S Spot and I

3
S Pattern apply as well to I

3
S Classic. Only 

the annotation is different, but searching, defining metadata, etc. is identical for all versions. 

2.6 Database conversion 

Both database structure and fingerprint format have been changed since I
3
S Classic v2.0. However, 

this distribution comes with a simple tool which will convert your old database to the new format.  
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Figure 2-2: Convertor application for old I
3
S 2.0 databases. 

 
The figure above shows the application. The first field allows you to select the directory of the old 

database. By default the value will be the directory in the I3S_DATA environment variable used by 

I
3
S 2.0. The second field is the target directory for the converted new database. Next, you are 

allowed to describe the contents of the database and the names of the three reference points to be 

used. If you press the buttons Whale Shark Refs or Ragged tooth refs the application will change the 

names of the reference points to the standard names for these species. Of course, you are 
completely free to choose other names. 
 

When all settings are to your liking, press Convert database to start the conversion which will last 

seconds to minutes depending on your database size. 
 
 
 

! 
 

The convertor tool will never discard or change your existing database! It will either leave 
the directory unchanged or rename the directory to the current name extended with 
“_old”. 

 
If you want to store the new converted database somewhere in the C:\Program Files 

(x86) directory you may run into problems with Windows and User Account Control 

(UAC). The convertor tool does not allow conversion in this case and requires you to 
select a location outside the C:\Program Files (x86) or C:\Program Files 

directories. A proper location would be C:\ClassicData. 
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3 Data management 

3.1 Introduction 

I
3
S compares unknown images with an identification database consisting of a collection of image-

fingerprint pairs. In this document, with the term ‘identification database’ we mean: a structured 
directory containing the collection of all known images used for reference by I

3
S. Possibly you will 

have another database or collection of either known or unknown images, but that is considered an 
entirely different database. 
 
A fingerprint file containing all information added in the annotation process accompanies each image 
file. Always treat these images as an inseparable pair. If you move one of the files manually to 
another directory you should always move the other file along. 
 
Earlier versions of I

3
S only allowed one identification database. At installation the user had to select a 

specific directory where the data was stored. Multiple identification databases (either other types of 
animals or other locations) where not supported and resulted in the need to rename and swap 
database directories.  
 
I
3
S Classic v4.0 allows you as many identification databases you need. The locations of data 

directories are stored at an individual level (specific: in the registry in HKEY_CURRENT_USER), so it is 

possible to have multiple users using the same pc or laptop and manage their own databases as well 
as manage shared databases. 
 

All database management is found under the menu item Database, see §4.1.3 for details on their 

use. 

3.2 I3S management tools 

I
3
S offers the following tools for data management: 

 
1.  Search in database Compare an annotated image against the entire identification 

database and show a ranked list of results. The lower the 
score, the better the match. 

2.  Insert in database Add an annotated image to the identification database. Either 
add it to an existing individual or insert it as the first image of a 
new individual. 

3.  Reload database In case you have manually added or removed files to the 
identification database directory you can reload the current 
database to incorporate the changes. 

4.  Change database Load another database from the list of known databases. 

5.  New database Start a new identification database and add it to the list of 
known databases. 

6.  Rename database Rename an existing database directory. 
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7.  Edit database list Remove a directory from the list of known identification 
databases or add a directory. The latter is used to add an 
existing identification database. 

8.  Edit metadata Edit the metadata structure of the current identification 
database.  

9.  Batch compare If you have a large batch of new photos, e.g. collected at a field 
trip, and you do not want to wait for the time to compare each 
annotated photo against the database, this option is useful. 
Just put all annotated photos in a single directory and let I

3
S 

process all at once. You can read in the results and process 
the data later. 
 
Further, if you want to compare two databases, e.g. to 
establish whether individuals migrate between locations, batch 
comparison allows you to find the best matches with almost no 
manual interaction. The results are written to an MS Excel 

readable csv file. 

10.  Process batch results Process the results in the file resulting from batch compare. 

For each compared image a search window with the results is 
shown. 
 

11.  Convertor old database Start separate application to convert an old I3S 2.0 database to 
the new format. 

3.3 The database directory 

All data in an identification database is structured by means of a directory tree. Images are stored in 
a separate subdirectory for each individual in the identification database. Each image is described by 

its pattern(s) and by means of metadata fields stored in the fingerprint file with extension .fgp. In 

older versions of I
3
S, the sex and various views where stored by means of subdirectories under the 

subdirectory for the individual. Starting with v3.0, sex and views can be covered by the metadata 
structure. You are however required to define this yourself.  
 
The top-level directory of an identification database contains for all known individuals a 

corresponding directory, the file metadata.xml, a directory named _ErrorLogs for error reports by 

the software, and an optional directory _SearchResults with the outcome of the various searches 

and evaluations.  
 

For example: 
 

Directory Description 
C:\I3S\RaggieData Top-level directory. It contains directories for the individuals 

Jimmy, Ronald, George and Bill and the directory 

_ErrorLogs. 

C:\I3S\RaggieData\Jimmy This subdirectory contains image and fingerprint files 

Jimmy001.jpg, Jimmy001.fgp, Jimmy002.jpg, 

Jimmy002.fgp. 

C:\I3S\RaggieData\Ronald This subdirectory contains image and fingerprint files 

Ronald.jpg, Ronald.fgp, Ronald2.jpg, 
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Ronald2.fgp, DSC_00261.jpg and DSC_00261.fgp.  

 
The subdirectories for individuals should only contain image files and fingerprint files (extension 

.fgp). Other file types are ignored. The image files should be of type JPEG (extension .jpg or 

.jpeg) or GIF (extension .gif). Each fingerprint file corresponds with the identically named image 

file (apart from the extension). A fingerprint file contains all the spot information and extra information 
of the corresponding image file. The sample identification database provided with the distribution 
contains several individuals (i.e. subdirectories).  
 
 
 
 
 
 
 
 
 
At start-up, I

3
S looks up the list of known databases. In case the list contains only one, this database 

is loaded directly. If the list is empty, you have to create a new identification database first or select 
an existing database with a browser. In case the list contains more than one, you are asked to select 
a database from a list. After selection, the application starts to parse all the fingerprint files in the 
corresponding individual subdirectories. All fingerprint files are stored in memory for quick future 
reference during execution of search tasks. Since the fingerprint files are quite small (usually a few 
kilobytes) the memory use of the database will be limited. 

3.4  Metadata 

Each identification database has its own metadata definition. For example it is possible to define 
metadata fields to indicate length, size, sex, scars, or whatever you want to define for an individual. 
When searching the identification database, it is possible to search on the metadata as well. The 

exact metadata definition is stored in the file metadata.xml stored at the top of a database 

directory. It is strongly advised not to edit this file manually but to use the graphical interface provided 
by I

3
S for this purpose. 

 

I
3
S currently supports four types of metadata fields: number, smallmediumlarge, yesno and 

Custom. The number format will accept any number such as 0, 12, 4.2 and -5. The type 

smallmediumlarge is a variable with three possible values (small, medium and large). Analogous, 

the yesno type is a Boolean variable with values yes or no. Custom lets you define a discrete and 

limited set of values yourself. 

3.5 Error checking on the database 

If you manually change the database, e.g. by moving around files or directories, you might introduce 
errors. I

3
S will check for some errors when parsing the database. The checks performed by I

3
S are: 

 
1. Does each fingerprint file have a corresponding image file in the same directory? This error 

typically occurs if you move the image file but forget the fingerprint file or vice versa. 
2. Are there subdirectories within individual directories? A warning is generated that the 

contents of these directories are not parsed. 
 
If there are errors found a pop-up window is generated. A description of all problems found is written 

to the file db_errors.txt in the _ErrorLogs directory of the database. 

Do not add extra directory levels as these will not be parsed!! An example of a directory 
(Field trip 2013) which contents will be ignored: 
 

C:\I3S\RaggieData\Ronald\Field trip 2013\  

 
! 
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4 The I
3
S user interface 

This chapter will address the possibilities of the I
3
S user interface. First, the menu bar and toolbar are 

described. Next, the interaction with the annotation panel is discussed. 

4.1 The menu bar 

I
3
S offers a standard Windows look & feel menu-based interface to perform most operations. In the 

paragraphs below, the six menu items will be explained. An overview of the title and menu bar is 
shown in Figure 4-1. The title shows the application name version and some details about the 
database: name, type and between brackets the number of fingerprints and individuals in the 
database. 
 

 

Figure 4-1: The I
3
S menu bar. 

4.1.1 The File menu 

This is the main I
3
S menu. Figure 4-2 shows the various operations, which are discussed below: 

 

 

Figure 4-2: the file menu. 

 

 Open image (shortcut CTRL+O). It will open a window to choose an image file. The supported 

image types are JPEG and GIF. The starting directory will be the top level directory of the 
selected database. If an image file has a corresponding fingerprint file (i.e. the same name but 

extension .fgp) a shark logo is shown, a standard image logo otherwise. The logos are shown 

below: 

  (with .fgp)   (without .fgp) 

 

 Save fingerprint (shortcut CTRL+S). If you have annotated an image this operation will write a 

fingerprint file in the same directory as the corresponding image together with any metadata. 

Apart from the extension, which is .fgp, the name will be identical to the name of the image file. 

 

 Close image. It closes the image in the main window. If you have unsaved data I
3
S will prompt 

you whether you want to save the data first. 
 

 Print image (shortcut CTRL+P). It will print the current image including comments (see §4.2). 
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 Exit (shortcut CTRL+X). This operation will close all windows. In case of unsaved data I
3
S will 

prompt you whether you want to save the data first. 
 

 
 

 

Figure 4-3: The edit menu. 

4.1.2 The Edit Menu 

 

 Undo and Redo are completely analogous to standard Windows functionality. The last 500 edit 

actions are kept in memory (Shortcuts: CTRL+Z and CTRL+R). 

 
 

 

Figure 4-4: The database menu. 

4.1.3 The Database menu 

 Search in database will compare the current image with the rest of the identification database. 

See Chapter 4.3 for details. 
 

 Insert in database In case of a loaded and annotated image, selecting this operation will allow 

you to add a new animal (i.e. a new subdirectory) to the identification database. This operation 
pops up a new window first that will prompt you for the name of the new animal. Selection of the 

checkbox Rename file will allow you to change the name of the image. By pressing Ok the image 

and its fingerprint file are copied (not moved) to the appropriate directory in the identification 
database. The figure below shows an example. If the file has been renamed, you are asked 
whether the original file needs to be renamed as well. 
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Figure 4-5: Insertion in the identification database. 

 

 Reload database If the identification database has been changed, i.e. fingerprint files have been 

manually added or removed using e.g. Windows explorer, this operation will reload the entire 
database. You do not have to call this operation after insertion of a new animal in the 
identification database. In this case, I

3
S will reload the database automatically. 

 
 

 

Figure 4-6: Changing the database. 

 

 Change database If you have multiple identification databases it is possible to load another 

identification database without exiting the application. This menu option will offer you a list to 

choose the database. Choosing the current database is identical to Reload database. Before 

changing the database, open files are closed and/or you are asked whether to save first. 
 

 New database If you want to create a new identification database choose this menu option. First, 

you are asked to select a new directory, either by typing it in at the text field Folder name or 

selecting the Create new folder button. Figure 4-7 shows the window. When you nevertheless 

choose an existing directory, the application will ask to create a new directory within the chosen 
one. After selecting a new directory, you are offered the window shown in Figure 4-8. Use this 
window to specify the database name. Type in a concise name as it is also shown in the top of 
the main application window. You can also change the description of the reference points. 
Further, it is possible to add a number of metadata fields to the identification database.  

 

 Rename database This option allows you to rename the directory of an existing database. First, 

you are asked to select an existing database, and then to type in the new name. Only letters, 
digits and spaces are allowed. After renaming, you are asked whether you want to change to this 
database. 
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Figure 4-7: The first step in creating a new database, directory selection. 

 
 

 

Figure 4-8: Setting-up the database (non-expert mode). 
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Figure 4-9: The window to edit the database list. 

  

Figure 4-10: The window to edit the metadata (expert mode). 
 

1 
2 

3 

4 5 
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 Edit database list If you want to remove an old database from the list of known databases or 

add an existing database directory you can use this option. Figure 4-9 shows the 

corresponding window. Remove deletes the selected directory from the list but it leaves the 

files in the map untouched. Add lets you select an existing directory and adds it to the list 

without checking whether it is a valid identification database directory (this will happen when 
the database is actually loaded). 

 

 Edit metadata This option allows to edit the metadata fields for the current database. Figure 

4-10 shows the window. 
 

The red numbers 1 to 6 indicate some important aspects of this window: 
1. The field database name defines the name which is shown in the title of the application. 

Press the button  to alter the name. When editing a field, it is not possible to select 

other buttons, except Cancel or  again to save the result. 

2. Names of the three reference points. 
3. The expert settings are only available in “expert mode” (see also paragraph 4.1.5). The 

 will show a pop-up window explaining each variable. These variables are used for fine 
tuning the recognition algorithm. You are also referred to paragraph 6.6. 

4. Use the left column of buttons to edit the names of the metadata elements. 
5. Press the button  to remove the field.  
6. Press the button  to edit the names of the custom field type. This button is only 

available for type custom as only this type allows you to define a list of possible values, 
as is shown for type ‘sex’. When pressing this button the window is enlarged to show the 
fields to edit the possible values as shown above. All other elements are greyed out, 

except for Cancel and the buttons to edit the fields for the custom element. The minimum 

number of values must be two, the maximum is limited to 10. Close editor stores the list 

of values (if valid) and returns the window to the previous state. 
 

 Batch compare. With this option you can compare a directory with annotated images directly 

with the identification database. This feature might be useful if you have a large batch of new 
photos, e.g. collected at a field trip, and you do not want to wait for the time to compare each 
annotated photo against the database. Another application is to compare two databases to 
determine whether there is overlap in individuals to establish migration patterns.  
 

The results are written to an MS Excel readable csv file in the _SearchResults directory of 

the current reference database. After selecting Batch compare the window shown in Figure 

4-11 pops up. Choose the directory with your annotated new data and I
3
S will start with 

comparing each photo against the database. A progress bar keeps track about the time still 
required. After finalization a message is shown where the data is written. Use the options 
menu to specify how many of the best matching results are written to the batch results file. 
 

 Process batch results. This menu item allows you to process the results from the batch 

compare. Each compared image pops-up together with a standard search result window 
(paragraph 5.2). 

 

 Convertor old database. Start separate application to convert an old I
3
S 2.0 database to the 

new format. See paragraph 0 for more details. 
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Figure 4-11: The window to choose the batch directory (top) and the message  
confirming the export of all results to the csv file. 

 

4.1.4 The Tools menu  Option results 

Options results will pop-up the left window shown in Figure 4-12.  

 

The first part Logging results of the left options window concerns the automated logging of the 

searches performed. If logging is on, the outcome of each search will be written to a file in the 

database directory (subdirectory _SearchResults). 

 

The naming of the file is SearchResults__<date>_<time>.log. For example, a search on the 

second of July 2013, at the time of 17:22:10 will be written to the file named 

SearchResults__20130702_172210.log. The content of the log file is identical to the results in 

the search results window. Each line contains a filename and the score separated by tabs. Excel can 
process this format. 
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Figure 4-12: The two option windows. 

 

The second part File or folder in results window will determine whether the results window will show 

the last directory of a matching file, or the filename itself. If you choose the filename, please make 
sure each filename identifies the individual by name or code. 
 

The third part All or best individual match is used to choose between showing all matching files in the 

database or just only the best file from an individual directory. 
 

The fourth part Show results can be used to indicate whether you are interested in the top 50 of best 

matches or the entire identification database. This choice will affect both the logging and the search 
results window. 
 

Finally, Number of batch results determines how many matches are shown when batch processing. 

For example, each time an unknown fingerprint from the batch directory is compared against the 
database only the top number of matches is stored. 
 

4.1.5 The Tools menu  Options general 

Options general will pop-up the right window shown in Figure 4-12.  
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The first part allows you to choose whether you want to get a warning when you drag your mouse 
during annotation. I

3
S requires you to keep the mouse completely still when clicking on a spot. If you 

have once chosen never to be bothered ever again you can correct this here. 
 
The second part determines whether I

3
S is in expert mode or not. When in expert mode, the expert 

menu is shown, while editing the metadata shows more options. 
 
The third part allows you to choose the interaction with respect to updates. When choosing 

Automatically check for updates the software will check periodically without interaction. Only when an 

update is found you will be asked whether you want to install. Ask to check for updates will make 

sure I
3
S gets permission before an update check. Never check for updates will make sure I

3
S never 

bothers you about updates, unless you manually choose Check for updates from the help menu.  

 

The fourth part named Color settings allows you to select which colors to use for the annotation 

elements. This can be particularly helpful if the species under study happens to show colors similar 
to the default colors used or if you are color blind. 
 

The final part named Number of threads to use determines how much I
3
S may use of the parallel 

processing capabilities of your computer. Default is 1 thread. If you increase this number, recognition 
speed will increase as well, however, other tasks carried out in parallel may also become slower (e.g. 
word processing, Excel, etc.). Experiments indicate a maximum speed-up of 3 compared to a single 
thread (see §6.2 for details). Any time you can set this level to the desired value. 
 
 

 

Figure 4-13: The expert menu. 

4.1.6 The expert menu 

This menu item is only available when expert mode is chosen with the Options general menu under 

Tools. See also the previous paragraph. This menu offers two evaluation options: simple and 
elaborate evaluation.  
 
 
 
 
 
 
 
 
 
Simple evaluation 
This option is used to get an indication how good the various instances of the same individual match 
with each other, and whether I

3
S can be used for matching a certain species. All fingerprints in the 

database are compared with all other fingerprints. If a match between two instances of the same 
individual yields a score outside the top 10 of best matches this is logged. After the entire database is 
matched with itself, an overview is produced which may look like this: 

If you have multiple regions of interest per individual, e.g. left and right side photos of the same 
individual, make sure to put them in different directories before doing the evaluation. For example, 
make two different directories for Turtle73: Turtle73_Left and Turtle73_Right. Otherwise, the 
evaluation tool will count mismatches between right side photos and left side photos incorrectly as 
errors (the evaluation tool does not consider the metadata). 

! 
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Simple evaluation results  
# intra individual comparisons: 210 The number of comparisons between 

fingerprints of the same individual. For 
example, in a database with 10 individuals and 
3 annotated photos per individual, this number 
will be 60 as each of the 30 fingerprint has two 
possible matches. 

Accumulated ranking score:      1218 For each comparison between two fingerprints 
of the same individual, the found ranking is 
added to a total. If the match between two such 
fingerprints results in a 15h place in the total 
ranking, the total is increased with 15. 

Best possible (ideal)  score:   273 This is the best score theoretically possible. In 
the database with 10 individuals and three 
fingerprints per individual, each of the 30 
fingerprints ideally has its two other sibling 
fingerprints ranked 1 and 2. In this case, the 
ideal score would be 30x1 + 30x2 = 90. 

Evaluation took 13 seconds (3,98 

msec per comparison, 3306 

comparisons). 

Some statistics about the total number of 
comparisons and the time required. 

Top #1:  133(63,33%) The top #X defines the number and percentage 
of comparisons resulting in a ranking in the top 
X of results. 

Top #2:  174(82,86%) 

Top #3:  186(88,57%) 
Top #5:  189(90,00%) 
Top #10: 195(92,86%) 

Top #20: 199(94,76%) 

 
The results of the evaluation are written to a file in the database directory (subdirectory 

_SearchResults). The naming of the file is EvaluationResults__<date>_<time>.log.  

 
 
Elaborate evaluation 
Elaborate evaluation simulates a realistic scenario. After selecting this menu option, the window in 
Figure 4-14 is shown. The user can select the number of iterations and the number of reference 
images. Next, I

3
S basically separates the database in a reference set and a test set. From each 

individual directory, the specified number of reference images is randomly selected and added to the 
reference set. All remaining images are added to the test set. Next, each test image is compared 
against the reference set. Statistics are kept about the number of times the right reference image 
shows up in the top 1, 2, 3, 5, 10 and 20.  
 
The output may look like: 
 

Elaborate evaluation results 

1000 repetitions, 3 reference images. #refs: 447  #test: 292 

 

Expert settings   MaxAllowedDist: 0.01   MinRelDist: 1.5 

Filling the matrix: 3172 seconds 

Random iterations:  1031 seconds 

 

Top #1:  266731 (91,35%) 
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Top #2:  276891 (94,83%) 

Top #3:  279618 (95,76%) 

Top #5:  281719 (96,48%) 

Top #10: 284117 (97,30%) 

Top #20: 285706 (97,84%) 

 
On this specific database of 739 ragged tooth shark images, using 3 reference images per shark, 
gives 95,76% probability that when comparing a new image of an individual already in the database, 
the proper individual is found in the top 3.  
 
More reference images will in general yield better results. However, more reference images will make 
the set of remaining test images smaller, which could result in less significant experimental results. 
 
Because the distinction between reference and test images is based on random selection, you need 
to repeat the process a lot of times to average out any random effects. The iteration parameter 
determines the number the process is repeated. The default value is 100. A 1000 iterations will 
require more time, but because of a pre-processing step, 1000 iterations will require relatively little 
more than the time needed for 100 iterations.  
 
 

 
 

Figure 4-14: Elaborate evaluation window. 

Evaluation of the database may be very time consuming. A good indication of the time required is the 
time needed for a single comparison against the entire database x the number of fingerprints in the 
database. During processing you can change  the amount of CPU power used by the evaluation 
process by adjusting the slider towards ‘slow’ or ‘fast’. Faster evaluation might make other 
applications less responsive. 
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Figure 4-15: The Help menu. 

4.1.7 The Help menu 

 

 Open manual will start your default PDF reader and open this manual. 

 

 Check for updates… will check if there are updates. If an update is available you will be asked 

only once to install at the next start-up of I
3
S, even if update checking is disabled. For successful 

installation Windows User Account Control has to be turned off. 
 

 Go to the I3S website will open your default web browser and show the I
3
S website. 

 

 Video tutorials at the I3S YouTube channel will open your default web browser and shows the 

start page of the I3S channel at YouTube. 
 

 About I3S… shows a window with information on version number, authors, copyright and contact 

details.  

4.2 The tool bar 

Below the menu bar I
3
S shows a tool bar, which offers short cuts to functions described in the 

previous paragraphs and some new functions. An overview of the tool bar is shown in Figure 4-16. 
 
 

 

Figure 4-16: The tool bar. 

 
The table below describes the various items in detail. 
 

 
Open file. Button for the menu option described in §4.1.1. 

 
Save file. Button for the menu option described in §4.1.1. 

 
Print file. Button for the menu option described in §4.1.1. 

 
Search. Button for database search described in Chapter 5. A keyboard 

shortcut is ALT+S. 

, ,  
Controls for zoom. Pressing the plus will zoom in on the image. If the 
enlarged image does not fit the screen two sliders will appear. The 
mouse wheel can also be used for zooming. The minus will zoom out. 
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The zoom factor is displayed right of the minus. The maximum allowed 
zoom factor is 1000%. 

 or  
Activate or de-activate edit mode. If yellow, editing is activated. If grey it 
is not active. 

 or  
Edit the information field. Each fingerprint file contains an information 
field. Upon pressing the button, a metadata editor is opened (see §5.1 for 
details). If the button is grey you need to activate the edit mode first. 

 or  
Change indicator. If the annotation has changed the button becomes 
yellow until the fingerprint is saved. 

 
A field, which will show instructions or the number of spots during 
annotation. The field is larger in the application. If a message is shown, 
the field will be yellow. 

 
 

 

Figure 4-17: Annotation of the last reference point with instructions 
in the yellow text field. (Image source: Univ. Kwazulu Natal) 
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4.3 Spot annotation 

4.3.1 The reference points 

For the algorithm it is essential to have a first indication how two images roughly match. For this step 
the reference points are used. If the reference points are not annotated, I

3
S requires you to annotate 

these first. Before you start, activate edit mode first ( ).  
 
The reference points are annotated by clicking with the left mouse button the three reference points 
in a fixed order. Do not mix-up these reference points as this will obstruct proper recognition! If you 
click a wrong position you can undo this by clicking with the middle or right mouse button. The text 
field will show in bright yellow which reference point to annotate. In the example in Figure 4-17 the 
text field shows “Point out Pelvic as third reference point”. 
 
You are entirely free to choose your own reference points. Give them proper names which make 
sense and which are not easy to mistake for each other (names like ref1, ref2 and ref3 are not a 
good idea). Further, the reference points should be clearly visible in all images and in an ideal case 
they should form a triangle with 60 degree angles. 
 
For ragged tooth sharks, we chose the following reference points: 

1. Start of first dorsal fin. 
2. Start of second dorsal fin. 
3. Start of pelvic fin. 

 

4.3.2 The spots 

Next, you have to annotate all relevant spots. Just click with your left mouse button in the middle of a 
spot. You can undo your latest action by clicking the middle or right mouse button (or using CTRL-Z 
and CTRL-R). 
 
Please be as accurate and consistent as possible in your annotation. Just because recognition is a 
partly automatic process, this does not mean that the human is not vital. Any computer program, and 
I
3
S is not an exception, works according to the principle of “garbage in  garbage out”. 

 
You are also referred to the relevant tutorial on the I

3
S YouTube channel. 
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5 Searching and using metadata 
This chapter discusses the search process in more detail. First, the options to add metadata are 
discussed. Next, the search process is described in detail. 

5.1 Adding metadata 

I
3
S allows you to add metadata to an image. Metadata is additional information, which describes the 

individual, location or perhaps the conditions in which the image was taken. If you press the  button 
in the toolbar a new window pops up. The window is shown in Figure 5-1. 
 
The upper text field allows you to store plain text. There is no limitation to its length. If no text has 
been added yet, ‘Empty comment field’ is shown.  
 

The Metadata elements field below allows for a more structured input. Four types of fields are 

available: numeric, general size with three possible values (small, medium, large), Boolean (yes/no) 
and custom. The latter is a finite user-defined set of values. The window below shows an example of 
each type. The numeric field expects a number using the keyboard. Selecting a value from the 
dropdown menu sets the other types. I

3
S allows you to include metadata elements in the search 

process described below. 
 

 

Figure 5-1: The metadata window. 

 
The metadata fields are not fixed and can easily be edited by the user. The metadata structure is 

defined in the file metadata.xml in the database directory but I
3
S provides a tool to edit the 

metadata. For more information you are referred to §4.1.3. 
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5.2 The search process 

After selecting Search in database from the Database menu or pressing the search button , a new 

window will appear as shown in Figure 5-2.  
 

 

Figure 5-2: Default search window. 

 
By default all defined metadata elements are set to “don’t care”. You can also indicate how the 
search process should act if an individual does not have a specific metadata element defined. By 
default, the search will not fail on missing metadata. 
 

If the search button is pressed, the current annotated photo will be compared against the entire 

database without considering the metadata elements in the fingerprints. If the search takes more 
than a second, a progress bar is shown. 
 
 

 

Figure 5-3: Search window with metadata criteria. 
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You can also search on specific metadata. The metadata structure is defined for the entire database 

in the file metadata.xml in the top of the database directory. You can select per type of field the 

appropriate constraints (e.g. equals, is less than, is greater than or don’t care). If you select the 

default don’t care, that field will not affect the search process. If one or more metadata elements do 

not satisfy the search constraints, the specific image is put at the end of the list of search results. If a 
metadata element is not available (i.e. not yet annotated) the search process will ignore this specific 
element and not exclude the image if you select “Match positive when metadata is unknown”. 
 
Figure 5-3 shows the search window with specific constraints set for the metadata elements. In this 
case, the search will only consider fingerprints with a left (or unknown) view, with sex ‘male’ or 
unknown, size greater than 20, and not tagged  or unknown. 
 
 

 

Figure 5-4: Search result window. 

 
 

When you click Search the Search result window shown in Figure 5-4 appears. Top left shows the 

unknown individual. The right side of the window shows the ranked list of photos from the database, 
10 at a time. With the vertical scroll bar you can scroll along the current set of 10. When the window 

opens, the best ranked photos 1 to 10 are shown. The buttons Prev, Next and Start allow you to go 

to the previous set of 10, next set of 10, or the first best 10. If currently matches 1 to 10 are shown, 
next will show 11 through 20.  
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Figure 5-5: Image (top) and spot cloud (bottom) pane. 
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By clicking one of the results in the list, the item turns yellow and the button Visual comparison 

becomes clickable. When clicking it, a new window named “Compare results” will appear as shown in 
Figure 5-5. The window contains four tab panes. The first shows both images together with the 
annotated pattern and comments. The second and third tab pane shows the image of the unknown 
animal and the selected animal from the results list respectively. The fourth tab shows the normalized 
patterns in the same recognition space where the known fingerprint is transformed optimally to have 
the best fit with the unknown fingerprint. 
 
The first pane is equipped with a built-in magnifying glass. When you move the cursor over one of 
the images the magnified part is shown to the right. Click with the left mouse button in the image to 
lock or unlock the magnifying glass. When locked the symbol of a yellow lock is shown. Locking the 
magnifying glass allows to compare two parts of the image in detail. By scrolling with the mouse 
wheel you can change the amount of magnification. 
 

The button  indicates whether AutoZoom is on or off. When yellow, AutoZoom is on. When ‘on’ the 
visual comparison window will zoom in on the identification area. Figure 5-6 shows the difference. 
 
 

  

Figure 5-6: With or without AutoZoom. 

5.3 Actions after the search is completed 

Based on the information in the ‘Compare results’ window you will ultimately decide whether the 
individual is already known or unknown. You have four options how to proceed and four 
corresponding buttons at the bottom of the window: 
 
1. The individual is known and because the image is of good quality you want to add it to the 

identification database as reference in future searches Press Include in database. 

2. The individual is new and you want to add it to the identification database in a new individual 

directory. Use the button New individual. 

3. The individual is recognized but you do not want to add it to the identification database. You only 
want to rename the image at the current location, e.g. in your own database. Use the button 

Only identification. 

4. You do not want to undertake any action. Press Close. 

 
Figure 5-7 shows these buttons in more detail. 
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Figure 5-7: The four other buttons at the bottom of the visual comparison window. 

 

5.3.1 Include in database 

Only add good quality images to the identification database. Poor quality images (e.g. large 
deviations from a perpendicular viewing angle with respect to the animal) will lead to poor quality 
search results. Ideally, aim at having about three reference images per individual in the identification 
database. When clicking on the ‘Include in database’ button the following window will appear. 
 
 

 

Figure 5-8: The 'Include in database' window. 

 
 

By clicking the field Rename file you can also edit the filename. The fingerprint file will get the same 

name, only with extension .fgp. We strongly advise to make sure that each filename contains the 

identification number or name of the individual. After clicking Ok both the image and the fingerprint 

file are copied (not moved) to the same directory as the matching image you selected. If you have 
renamed the file, you will be asked whether you want to rename the original file as well. 

5.3.2 New individual 

If no matching individual was found you will probably assume it is not yet in the identification 
database. To add it to the database, click on the appropriate button. The following window will 
appear. 
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Figure 5-9: The 'New individual in database’ window. 

 
Fill in the name of the individual. This can be a name like ‘Gregory’ or just a number such as ‘Raggie 
301’. This name will be the name of the new directory. In the next section you can choose to rename 
the image and fingerprint file. We strongly advise to rename the file so it represents the identity. For 

example, in case of Gregory you could name the file Gregory-12March2009Yap.jpg. After 

clicking Ok both the image and the fingerprint file are copied (not moved) to the new directory in your 

identification database you just specified. If you have renamed the file (which you should have), you 
will be asked whether you want to rename the original file as well. 

5.3.3 Only identification 

If you have successfully identified an individual but do not want to include the image in the 

identification database, you still might want to rename the file. In this case, press Only identification 

and the following window will appear. 
 
 

 

Figure 5-10: The 'Only identification window'. 

 

Fill in the new name and make sure it ends with the proper extension (most likely .jpg) and press 

Ok next. Both image and fingerprint file will be renamed. 
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6 Some final thoughts on I
3
S 

6.1 Recognition performance on ragged tooth sharks and whale sharks 

 
Using the evaluation tool described in §4.1.6, I

3
S has been evaluated on a ragged tooth database. 

The database consisted of 739 images. The output of the test was: 
 

# intra individual comparisons: 3742 

Accumulated ranking score:      150773 

Best possible (ideal)  score:   16225 

 

Top #1:  601(92,32%) 

Top #2:  627(96,31%) 

Top #3:  631(96,93%) 

Top #5:  633(97,24%) 

Top #10: 639(98,16%) 

Top #20: 641(98,46%) 

 

Thus, when offering a photo of an individual with one or more photos of the same individual in the 
database, in 92.32% of the cases a proper match is shown as the first candidate, while in 98.16% of 
the cases one or more matches are shown in the top 10. Analysis of the poor matches indicates that 
angle is a leading cause. Below an example of a poor match is shown where the image on the left is 
taken with a vertical angle while the example right is taken with a considerable horizontal angle: 
 

     

Figure 6-1: Example of a poor match caused by viewing angle.  
(Image source: Univ. of Kwazulu-Natal) 

 
For a more elaborate test on whale sharks you are referred to the following link: 
http://www.reijns.com/i3s/I3S%20Evaluation%20Whaleshark.pdf 

http://www.reijns.com/i3s/I3S%20Evaluation%20Whaleshark.pdf
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6.2 Speed of I3S 

I
3
S can make use of the multiple cores available in all modern computer CPUs. If making full use of 

multi-threading,  I
3
S is about 2.4 times faster compared to only a single thread (on the computer used 

for development, 2 cores). The options menu allows to set the maximum number of separate threads 
for recognition (see §4.1.5). Experiments indicate that it is not useful to have more threads than twice 
the number of processor cores/threads available to Java. By using all threads the computer may 
become unresponsive to other applications.  
 
On the development hardware (Intel Core i5 3320M @ 2.60GHz from 2013, DDR3 RAM @ 800 
MHz), with almost 26 spots on average per individual, comparison time between two photos with 
various numbers of threads is shown in the table below. 
 
 

# threads Time per 
comparison 

Speed-up vs. 
1 thread 

1 9.27 msec 1,0 

2 5.51 msec 1,7 

4 4.16 msec 2,2 

6 3.98 msec 2,3 

8 3.94 msec 2,4 

6.3 Limitations of I3S 

Although the family of I
3
S tools has been shown to work on a large number of species, there are 

some limitations you should consider. Below we will discuss the two most important issues. 
 

1. 2D vs. 3D. The main limitation is that a 2D model is used for a 3D animal. Especially with 
increasing observation angles the limitations of the 2D approach become apparent. 
Experiments on I

3
S Classic showed that accuracy deteriorates considerably with angles 

larger than 40 degrees. For the moment we therefore advise to use photos taken from a 
viewing angle smaller than 30 degrees whenever possible. This is particularly important for 
the photos (to be) included in the identification database. 
 

2. Linearity. We assume linearity of the animals. In plain English: we assume that the animals 
are rigid and their body parts are always in the same position with respect to each other, 
which is an optimal situation for comparison. Unfortunately, this is often not the case, 
especially if (e.g. with small animals) the entire body is used for identification. Using the head 
of animals has the advantage that you can safely assume linearity. The body is usually more 
susceptible to deformations, and the tail part even more. 

 

6.4 Data capture 

We have the following suggestions when collecting photo or video data: 

1. If you capture your subject, i.e. you take it out of its habitat to be photographed, please make 
sure that: 

 There are no reflections from sunlight. These reflections will cause local high lights 
making features much harder to annotate. Try to shield your subject from direct 
exposure. 

 Take photos from the same angle, perpendicular to the identification area with all 
reference points visible. 
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 If the entire body or a non-rigid area is used for identification, try to put your subject in 
a construction or rig where the identification area is always in the same position. 

2. Do not use direct flash as this will cause local over exposure in your image. If flash is 
necessary, use indirect flash instead. 

3. Do not reduce the resolution of the image. However, it is usually a good idea to crop the 
image showing only the relevant part. For example, Figure 6-2 shows the original photo at the 
left and a cropped version with only the relevant part at the right. Annotation and comparing 
images will be much easier with the right photo, while no information is lost provided you only 
crop and do not reduce resolution. 

4. Try to get the viewing angle as close to perpendicular as possible. Analysis shows that most 
mismatches are caused by deviations from the ideal viewing angle. 

5. Consider using HD video instead of photography. The advantage of videography is that it is 
possible to select the perfect frame. 

 

  

Figure 6-2: Original photo (left) and cropped photo in the same resolution  
showing only the relevant part (right). (Image source: aquarium.co.za) 

6.5 Is I3S right for your species? 

The only way to find out is to set-up an experiment. Ideally, you have at least thirty individuals and for 
each individual three or more photos of the same area of interest (e.g. right side of the head is 
another area than the left side of the head of the same individual). If you have left and right side 
photos of the same individual, make sure to put them in another directory, e.g. Raggie73_Left and 
Raggie73_Right. Otherwise, the evaluation tool will count mismatches between right side photos and 
left side photos incorrectly as errors (the evaluation tool does not consider the metadata!). Annotate 
all usable photos, and evaluate the database using the evaluation tool (§4.1.6). If for example more 
than 95% of photos of the same individual turn up in the top 5, you have a good indication it might 
work for more data. Please do not hesitate to contact us at  i3s [at] reijns.com  to think along with 
you! 

6.6 Under the hood of I3S 

Finally, we will discuss some internal variables of I
3
S. You can find these variables in file 

metadata.xml (§3.3). You can change the values by editing the file manually, but a simpler way is 

to use the expert mode while editing the metadata as described in §4.1.3. Changing these variables 
may have a large (potentially negative) impact on the recognition performance of I

3
S. 

mailto:i3s@reijns.com
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The relevant part of the metadata file is shown below: 
 

   <!--  Advanced settings: do not alter without instruction or                   

         really knowing what you are doing!!!!  --> 

   <minNrElements> 12 </minNrElements> 

   <maxNrElements> 30 </maxNrElements> 

   <maxAllowedDistance> 0.01 </maxAllowedDistance> 

   <minRelativeDistance> 1.5 </minRelativeDistance> 

    
Below we will discuss the variables. Four different variables are defined: 
 

1. MinNrElements/MaxNrElements, these variables define the minimum and maximum 

number of spots to be annotated. The default numbers (12 resp. 30) are optimized for ragged 
tooth sharks. Keep in mind: too few spots is not distinctive enough. Too many may result in a 
computationally expensive comparison, while increasing the possibility of a false positive 
match between two fingerprints. 

 

2. maxAllowedDistance, a floating point variable which defines the maximum SQUARED 

distance between two matching spots relative to the maximum distance between any two 
reference points. In this case, 0.01 (10% squared) means 10% of this distance! This variable 
is used to prevent matches between spots which are too far apart. 
  

3. minRelativeDistance, a floating point variable defining the minimum relative SQUARED 

distance between the best and second best matching spot. When comparing two fingerprints, 
i.e. two collections of spots, a spot from the first fingerprint might match with more than one 
spot from the second fingerprint. Usually, this happens more often in areas crowded with 
spots and this might result in a messy recognition. By demanding that the second best match 
is at a minimum distance of the best match, these messy recognitions are prevented 
improving the overall performance. xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx 
 
For example: the value is set to 1.5. Spot 1a (first fingerprint) matches with spot 2a and 2b 
(second fingerprint). The distance in recognition space between 1a and  2a is 9.5, and 
between 1a and 2b it is 8.1. The best match is therefore (1a, 2b). However, the relative 
distance between the two pairs is 9.5 / 8.1 = 1.173. Squared this distance is 1.376, which is 
less than 1.5. Therefore the match between 1a and 2b is discarded. 


